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  Abstract
There is an urgent need for conservation managers to undertake inventory and monitoring 
programmes for the endangered Australasian bittern (Botaurus poiciloptilus; matuku) in  
New Zealand. Such programmes can be used to determine the distribution and relative 
abundance of Australasian bitterns nationally; identify significant habitats, sites and populations 
to enable their protection and implement conservation management; measure the response and 
effectiveness of management practices; and measure the health of wetlands. This report describes 
four protocols for the inventory and monitoring of Australasian bitterns, and also provides a 
guide to choosing the most appropriate method for a particular objective. The protocols build 
on previous methods that have been developed in other countries, testing and adapting them 
for New Zealand conditions, and extending them through the use of automatic recording 
approaches, which allow efficient sampling in remote and inaccessible locations. The protocols 
represent current ‘best practice’, but further refinements will likely be made in the future.
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 1. Introduction

Management of threatened species is one of the major challenges faced by conservation 
managers. Managers rely on monitoring to assess whether species’ populations are declining, 
where declines are occurring, the rate of decline and the response of populations to conservation 
management (Kéry & Schmidt 2008). However, the development and application of monitoring 
methods can be problematic, even for the most perceptible of species—and when the target 
species is cryptic or difficult to detect, these challenges are even greater (Clarke et al. 2003).  
In the case of cryptic species, data are often difficult to interpret, and contain biases and errors 
that frequently cannot be estimated, making results less meaningful (Clarke et al. 2003). Yet the 
consequences of not monitoring these species are still high—a threatened cryptic species will 
only get harder to monitor as it declines, and without the ability to identify the causes of declines 
and reverse them, extinction can become inevitable. 

The Australasian bittern (Botaurus poiciloptilus; matuku) is a highly cryptic, endangered swamp 
bird that is threatened throughout its range in New Zealand, New Caledonia and southern 
Australia (Miskelly et al. 2008; Birdlife International 2013). Although Australasian bitterns 
are large, stocky birds, they are difficult to see at any time of the year and are one of the best 
camouflaged bird species in New Zealand (Fig. 1). Their streaky dark-brown and beige plumage 
allows them to blend in perfectly with the vegetation in most of the wetlands they inhabit 
(Heather & Robertson 2000). 

Globally, there has been little research on Australasian bitterns, and little has been published 
about the threats to and ecology of this species (Kushlan 2007; O’Donnell 2011). In New Zealand, 
bittern numbers were estimated at fewer than 800 birds nationally in the 1980s (Heather & 
Robertson 2000). There is currently no information regarding the extent of decline for this 
species (O’Donnell 2011), but historical anecdotal literature implies that these birds were once 
abundant and declines have been considerable (e.g. Potts 1869; Hamilton 1885; Buller 1892; 
Drew 1896). Australasian bitterns are reliant on wetlands for breeding and feeding (Heather & 

Figure 1.   a typically well camouflaged australasian bittern (Botaurus poiciloptilus) concealed in oi 
(Leptocarpus similis) rushlands. Photo: Peter Langlands, WildCapture.
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Robertson 2000; O’Donnell 2011), and present-day wetland areas in New Zealand represent only 
10% of their original extent (Ausseil et al. 2011). Thus, the decline in the bittern population is 
likely to have been proportional to this and severe. 

This report describes protocols for the inventory and monitoring of Australasian bitterns, 
developed as part of a Department of Conservation research programme that aims to provide 
tools for conserving threatened species. It also provides a guide to choosing the most appropriate 
method for a particular objective. The protocols represent current ‘best practice’, but further 
refinements will likely be made in the future.

 2. Definitions of inventory and monitoring

The objectives and design of a programme will vary depending on whether a person is interested 
in carrying out a one-off inventory (or baseline survey) of populations of a species at a particular 
site or sites, or in monitoring longer term population trends. 

Inventories usually focus on determining the significance of a site for a species. Information 
obtained may:

 • Simply determine the presence or absence of the species at a site—the presence of a 
threatened species at a site is significant in its own right (Myers et al. 1987)

 • Establish a baseline distribution map and map the number of individuals 

 • Associate sightings with habitat types 

Such information helps to determine where longer term monitoring and management should be 
focused; to assess a site’s significance in the context of the Resource Management Act (1991), or 
regional or local plans; or to assist with assessing ecological impacts of proposed developments.

Population monitoring requires longer term approaches, where counts are standardised and 
repeated using the same method at regular intervals. Monitoring is often conducted to:

 • Evaluate the conservation status and trend of a species (is it increasing, stable or 
decreasing?)

 • Assess the success of management and use the results to adapt or experiment with 
management practices

 • Report to others the results of management or population trends

 3. Why survey or monitor Australasian bittern 
populations?

Little information is available regarding current threats to bittern populations. Therefore, there 
is a need to quantify the extent of decline in bittern populations, determine where declines have 
occurred and identify factors causing these declines, so that key habitats can be managed and 
restored effectively (Buchanan 2009; O’Donnell 2011). To do this, there is an urgent need for 
conservation managers to undertake inventory and monitoring programmes that:  

1. Determine the distribution and relative abundance of Australasian bitterns nationally. 
These data are required to identify:

 a. Significant habitats, sites and populations to enable protection
 b. Important sites to implement conservation management 
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2. Identify the habitat requirements of Australasian bitterns at a national level. This is 
essential for identifying areas of importance and prioritising restoration efforts.

3. Measure the response and effectiveness of management practices at key bittern sites. 
For example, responses to pest control, habitat maintenance and restoration. 

4. Measure the health of wetlands. For example, bitterns can be used as an indicator species 
of the status of specialist wetland bird species, because they rely on good water quality, 
productive food webs, and healthy, fluctuating water regimes (White et al. 2006).

 4. Inventory and monitoring options for 
Australasian bitterns

Ideally, a complete count of a population would be made to measure its size and determine 
trends in abundance (Thompson 2004). However, it is impossible to undertake total counts 
of Australasian bittern populations because individuals are so well camouflaged and highly 
cryptic in the wetlands they inhabit. Furthermore, their cryptic behaviour and plumage means 
that they have a particularly low probability of detection using ordinary monitoring methods. 
Consequently, alternative indirect methods or indices of relative abundance are required.

The 12 living bittern species that make up the subfamily Botaurinae within the heron family 
Ardeidae (Kushlan & Hancock 2005) are all cryptic and a challenge to monitor. We reviewed 
the range of methods that is available globally for inventory and monitoring of these species 
(E. Williams, unpubl. data). This review showed that most standard monitoring methods 
(e.g. territory mapping, mark-recapture methods, vocal individuality, double observer approach, 
distance sampling) are currently inadequate for Australasian bitterns because they are 
extremely labour intensive, rely on identifying individuals, require high detection or re-sighting 
probabilities and/or have low precision; and more research is required before the feasibility of 
other potential methods (e.g. thermal imagery, camera traps, motion/heat detectors, use of dogs 
to detect scent) can be determined (E. Williams, unpubl. data).

Thus, we decided to develop protocols that are specific to Australasian bitterns, based on counts 
of the number of male bitterns booming (number of boom trains per sampling period, where one 
boom train can be defined as a sequence of individual booms uttered by a single bird; Gilbert et al. 
1994). 

 4.1 Development of the call count method
Research to develop and test the protocols outlined in Section 5 focused on optimising counts 
by identifying when booming bitterns are most detectable and least variable in relation to 
environmental factors, calibrating call counts against estimates of density, and designing 
protocols that suit a range of different situations (Williams et al., unpubl. data; O’Donnell et al. 
2013). The wealth of literature on monitoring bitterns and other swamp bird species in other 
countries using call counts was used as an initial guide (e.g. Poulin & Lefebvre 2003a, b; Lefebvre 
& Poulin 2003; Conway 2009). In addition, we also extended previous work by testing automatic 
recording approaches, which allow efficient sampling in remote and inaccessible locations. 
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 4.2 Assumptions of the call count method
The protocols outlined in Section 5 focus on counting booming male bitterns during the 
breeding season. They have been designed specifically to maximise detection rates and should 
be considered indices of relative abundance rather than true censuses, largely because we do not 
know how many female and non-booming birds are present in a wetland, and there may be an 
unknown number of birds that do not boom on any particular visit. Nevertheless, the protocols 
provide a count of booming males on a given day. Use of the number of booming males as a 
measure of relative abundance for a highly cryptic bird has been shown to be an informative and 
useful tool for conservation managers of the Eurasian bittern (Botaurus stellaris) (e.g. Adamo et al. 
2004; Poulin et al. 2009; van Turnhout et al. 2010).

 5. Protocols for inventory and monitoring of 
Australasian bitterns

 5.1 Presence/absence during call inventories (inventory only)

  About this protocol

 • Measures: Presence of bitterns during evening call inventories at a wetland, providing 
simple statistics such as:

 – The proportion of sites within a wetland with booming bitterns

 – Time to first detection

 • Means of detection: Detects the calls of breeding males (booms) using observer(s) 
stationed around a wetland or using automatic Acoustic Recording Devices (ARDs).

 • Suitability: This method is suitable for recording the distribution and presence of bitterns 
at a site. 

 • Advantages: A relatively quick method that requires a minimum of resources.

 • Disadvantages: Inventories provide little information on the relative abundance of bitterns 
and no data on population trends. Not detecting a bittern does not mean they are absent—it 
may be that birds were silent during the inventory because conditions were unsuitable 
or they were somewhere else in the wetland at the time. It is feasible that bitterns use 
certain wetlands at different times of the year or that conditions at a site are not suitable 
for bitterns every year; for example, bitterns will not be present if a wetland is dry in a 
particular year. Therefore, observers should examine historical records for their region and 
use common sense when assessing the adequacy of an inventory and whether repeated 
surveys are needed.

 • Differences between inventory and monitoring approaches: This method is not suitable 
for long-term monitoring of numbers, although it may be used to monitor changes in 
distribution.

  Field protocol

 • Observers position themselves at accessible locations (preferably c. 500 m apart) around 
the shores of the wetland, recording the presence of booming bitterns. Locations could be 
estimated using triangulation if the wetland is small (see Protocol 5.3). Acoustic Recording 
Devices (ARDs) can be used in place of observers (see Appendix 1 for instructions).
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  When should counts be made?

 • Time of year: Best during September, October and early November, during the peak calling 
season (Fig. 2). 

 • Time of day: If using observers, best during the peak evening calling period (30 minutes 
before local sunset to 1 hour after local sunset (Fig. 3B). Although the calling rate is often 
higher 1.5 hours before dawn (Fig. 3A), it is more practical for observers to work at dusk, 
and if bitterns are present at a site they are equally likely to be detected at dusk. However, 
if using ARDs, the dawn period should also be targeted.

 • Number of visits: If booming bitterns are present, it is reasonable to expect them to be 
detected in 1–3 nights of listening. If listening outside the peak period (e.g. early September 
or late November) when booming call rates are less frequent, it may be prudent to survey 
for more nights if birds were not detected after the third night.

 • Frequency: Opportunistic. 

 • Survey conditions: Conduct counts in calm, fine weather, and avoid listening during rain, 
strong wind and when there are other excessive noises (planes, trains, automobiles). See 
Appendix 2 for a list of criteria used by observers listening for bitterns in the field. Various 
weather variables also need to be obtained post hoc from local or national weather stations, 
including moon visibility, mean rainfall and cloud cover (E. Williams et al. unpubl. data), as 
this helps when analysing and interpreting the results. 

  Where should counts be made?

 • Number of count stations: Bittern booms can be heard over 1 km away in quiet conditions. 
Therefore, depending on the size of the wetland, presence could be relatively easy to detect 
from a minimum of listening stations. 

 • Location of count stations: Spread stations widely to obtain listening coverage of the 
entire wetland.

 • Distance between counts stations: Not fixed, but 500 m is adequate.

Figure 2.   Frequency of occurrence of records of booming australasian 
bitterns (Botaurus poiciloptilus) through the year. (Taken from the Department of 
Conservation national bittern database and updated from O’Donnell (2011);  
n = 212 reports)
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  Data recording

 • Datasheets: No specific datasheets are needed for presence/absence surveys, 
although the standard field form that is used for monitoring can be used (Appendix 3; 
DOCDM-12980921).

 • Data storage: Enter data into the Department of Conservation’s national bittern database 
(a Microsoft Excel spreadsheet; DOCDM-712082) or send records to the authors. 

 • Analysis and reporting: The level of analysis and interpretation that is possible will 
depend on the adequacy of the survey. Reporting will simply include whether any bitterns 
were recorded at the site, how many were recorded and their locations. 

Figure 3.   nightly pattern of mean (± Se) numbers of australasian bittern (Botaurus poiciloptilus) call 
sequences detected at a. sunrise and B. sunset at Whangamarino wetland, 2009–10 (vertical axes represent 
the time of sunrise and sunset). e. Williams et al. unpubl. data.

1. These numbers relate to the Department of Conservation’s internal file repository. If you do not have access to this, please 
contact one of the authors for a copy of this.

Time to sunrise (hours)

0

5

10

15

20

25

30

35

-1:00-0:30-0:010:290:591:291:592:292:593:29

M
ea

n 
ca

ll-
se

qu
en

ce
s p

er
 1

5 
m

in
ut

e

Time to sunrise

October

November

Mean number of bittern call sequences detected during morning surveys at 
Whangamarino wetland in 2009 and 2009, Error bars = SE, vertical axis represents sunrise 

a

M
ea

n 
ca

ll-
se

qu
en

ce
 p

er
 1

5-
m

in
ut

e 
in

te
rv

al

Time to sunset (hours)

0

5

10

15

20

25

-2:00-1:45-1:30-1:15-1:00-0:45-0:30-0:15-0:010:140:290:440:591:141:291:44

M
ea

n 
ca

ll-
se

qu
en

ce
s p

er
 1

5 
m

in
ut

e

Time to sunrise

October

November

Mean number of bittern call sequences detected during evening surveys at 
Whangamarino wetland in 2009 and 2009, Error bars = SE, vertical axis represents 

B

M
ea

n 
ca

ll-
se

qu
en

ce
 p

er
 1

5-
m

in
ut

e 
in

te
rv

al



8 O’Donnell & Williams—Monitoring Australasian bittern

 5.2 Estimate (index) of the number of booming males using close 
approaches in small wetlands (< 250 ha) (inventory and 
monitoring)

  About this protocol

 • Measures: Evening counts of booming males using observers in kayaks or other small, 
quiet watercraft who approach and map birds (O’Donnell et al. 2013). Counts can be 
repeated in the same way annually to obtain data on changes in:

 – The mean number of birds detected
 – The number/location of booming bitterns

 • Means of detection: Detects the calls of breeding males (booms) using an observer or 
observers moving around a wetland.

 • Suitability: This method is particularly suitable for small lakes that have a narrow fringe 
of swamp vegetation, as there will be little confusion between the locations of individual 
birds if the method is followed. This method is not suitable for larger wetlands because 
the ability to differentiate between individuals becomes less precise and inaccurate as 
the number of individuals increases and calls of distant bitterns overlap those of nearby 
bitterns. If observers get saturated by too many calling birds, or if there is insufficient 
time between calls to estimate the distance of calls reliably and distinguish individuals 
consistently, then results will be imprecise and variable. 

 • Advantages: A relatively quick method that gives immediate results.

 • Disadvantages: Only suitable in a limited number of situations (small lakes with narrow 
fringes of vegetation), and usually dependent on being able to use kayaks or other quiet 
watercraft.

 • Differences between inventory and monitoring approaches: Can be used for both 
inventory and monitoring. When this method is used for long-term monitoring, counts 
must be undertaken over a shorter standardised timeframe (see ‘Time of year’ below) with a 
minimum of three repeat counts for each survey period per year.

  Field protocol

 • Observers slowly circumnavigate the lake or wetland using a kayak, noting the presence of 
booming birds as they pass them around the margin. 

 • Observers quietly paddle towards each booming bittern, repeatedly taking note of the 
bearing and subjectively guessing distance. It is possible to quietly home in on booming 
birds without disturbing them by sitting off the reed beds in a kayak (O’Donnell et al. 2013). 
Booming birds will not take flight during the surveys if observers are quiet. It is possible 
to approach calling birds from more than one direction or even circle a calling bird to 
improve confidence in estimates of its location. 

 • When confident of the location of a booming bird, and that booms are not being produced 
by more than one bird at that location, observers note the location on a map or record the 
coordinates using GPS, and then move on to where the next bird is calling along the lake 
shore. 

 • This technique relies on spending as long as the observer thinks is required to be confident 
about the locations of all booming birds on the lake. For example, surveys of the 150-ha 
Lake Hatuma by O’Donnell et al. (2013) took 5 hours using one observer and 3.5 hours 
using three observers. 

 • Multiple observers should confer during and after surveys to confirm bittern locations.
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  When should counts be made?

 • Time of year: September, October and early November, during the peak calling season 
for one-off inventory, BUT a shorter period (last 2 weeks of September and all of October) 
during the highest calling period for monitoring (Fig. 2). 

 • Time of day: Afternoon surveys that intersect peak calling 30 minutes before local sunset 
to 1 hour after local sunset during the peak evening calling period (Fig. 3B). Although the 
calling rate is often higher 2 hours before dawn (Fig. 3A), it is more practical for observers 
to work during daylight.

 • Number of visits: 1+ nights for inventory; 3 nights for monitoring.

 • Frequency: Annual for monitoring. 

 • Survey conditions: Conduct counts in calm, fine weather, and avoid listening during rain, 
strong wind and when there are other excessive noises (planes, trains, automobiles). Cloud 
cover must be recorded, as this helps when analysing and interpreting the results  
(E. Williams et al. unpubl. data). For criteria, see Appendix 2.

  Where should counts be made?

 • Number of count stations: Not applicable.

 • Location of count stations: Not applicable. 

 • Distance between counts stations: Not applicable.

  Data recording

 • Datasheets: Use a GPS to record bittern locations or draw locations on a laminated field 
map.

 • Data storage: Enter data into the Department of Conservation’s national bittern database  
(a Microsoft Excel spreadsheet; DOCDM-712082) or send records to the authors. 

 • Analysis and reporting: Population trend analyses are relatively specialised, so the advice 
of a statistician is useful before analysing the results. Trend analyses can be graphed  
(e.g. Fig. 4) and distributions can be shown on maps (e.g. Fig. 5).
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Figure 4.   an example of graphical representation of australasian bittern (Botaurus poiciloptilus) monitoring 
data from call counts at Whangamarino wetland, September–november 2006–2010. Data show the mean  
(± Se) number of passive call counts lasting 1.5 hours at 12 fixed listening stations repeated over  
3 consecutive nights (e. Williams unpubl. data).
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 5.3 Estimate (index) of the number of booming males using 
triangulation in small wetlands (< 250 ha) (inventory and 
monitoring)

  About this protocol

 • Measures: Evening counts of booming males using observers who estimate the number 
and locations of individuals using simple triangulation (O’Donnell et al. 2013). Counts can 
be repeated in the same way annually to obtain data on annual changes in:

 – The mean number of birds detected
 – The number/location of bittern territories (e.g. Fig. 5)

Figure 5.   example of mapping the distribution of australasian bitterns (Botaurus poiciloptilus) at lake hatuma 
using triangulation from two fixed stations, June 2011. letters represent the locations of booming bitterns (after 
O’Donnell et al. 2013).
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 • Means of detection: Acoustic triangulation involves repeatedly taking compass bearings in 
the direction of booming bitterns from a minimum of two different fixed listening stations 
around the wetland that are surveyed simultaneously by observers over a period of time 
(Lefebvre & Poulin  2003). 

 • Suitability: The method is particularly suitable for small (< 250 ha) lakes that have a narrow 
fringe of swamp vegetation, as there will be little confusion between the locations of 
individual birds if the method is followed. This method is not suitable for larger wetlands 
because the ability to differentiate between individuals becomes less precise and accurate 
as the number of individuals increases and the calls of distant bitterns overlap those 
of nearby bitterns. If observers get saturated by too many calling birds, or if there is 
insufficient time between calls to estimate the distance of calls reliably and distinguish 
individuals consistently, then results will be imprecise and variable. 

 • Advantages: A relatively quick method that gives immediate results. Does not require the 
use of kayaks.

 • Disadvantages: Only suitable in a limited number of situations (small lakes with 
narrow fringes of vegetation) and usually dependent on being able to differentiate 
between individuals with sufficient precision to meet the study objectives (e.g. Fig. 5). 
Close approaches (see Protocol 5.2 above) appear to provide more accurate results than 
triangulation because the errors associated with taking compass bearings are minimised 
(O’Donnell et al. 2013). However, if kayaking is not possible, acoustic triangulation alone 
appears to provide a suitable index, although it probably underestimates the total number 
of birds booming. Formal triangulation, where intersections of bearings are formally 
mapped and error polygons calculated around estimated locations (White & Garrott 1986), 
is not recommended because previous attempts to do this indicated that error polygons 
were too large to be useful (C. O’Donnell & E. Williams, unpubl. data). 

 • Differences between inventory and monitoring approaches: If using this method for long-
term monitoring, counts should be carried out at the same time and in the same weather 
conditions each year, and three repeats should be undertaken per year.

  Field protocol

 • Use at least two accessible locations, c. 500 m apart to undertake counts. For example, at 
Lake Hatuma, all calling birds along the 2.4-km-long shoreline could be detected with two 
stations 500 m apart located in the middle of the lake shore (Fig. 5; O’Donnell et al. 2013). 

 • Count all males that boom during a 1-hour period at dusk.

 • Undertake bearings simultaneously whenever birds are heard booming. Record the time 
of the last boom in each boom train, compass bearing (in degrees), estimated distance (m) 
and number of booms within a boom train Individual booming males are distinguished 
using a combination of call direction and call characteristics (call volume and number of 
booms in sequence). Each time a bittern is heard, observers make a judgment as to whether 
the call was from a new bird, or one that had been previously heard within the count period. 
A call-sequence is recorded as a ‘new’ bird if the bearing of the new call is greater than 
ten degrees different from the bearing of any call heard previously; the bearing of the new 
call is within ten degrees of another call but falls into a different distance category; or the 
bearing of the new call is within ten degrees of another call, but consistently had a different 
number of booms within its boom sequence compared to the previous call. 

 • Immediately after the recording session each observer plots the location of each different 
bittern they heard on a map using the bearings (e.g. Appendix 4). Estimated locations are 
then compared to decide if observers were hearing the same birds or different birds. If 
the number of birds heard in one area is uncertain, observers should cross check boom 
characteristics such as time and number of booms in train to try to resolve this uncertainty. 
Be aware that the reliability of each observation will depend upon the observer’s 
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location with respect to the bird. If an observer is closer to a bird or has a better angle to 
differentiate then weight their opinion higher. After all uncertainties have been discussed 
observers agree on the total number of birds and their locations, and these are plotted on a 
master map (e.g. Appendix 4).

  When should counts be made?

 • Time of year: September, October and early November, during the peak calling season for 
one-off inventory, BUT over a shorter period (last 2 weeks of September and all of October) 
during the highest calling period for monitoring (Fig. 2). 

 • Time of day: Centre surveys on 30 minutes before local sunset to 1 hour after local sunset 
during the peak evening calling period (Fig. 3B). Although the calling rate is often higher  
2 hours before dawn (Fig. 3A), it is more practical for observers to work at dusk.

 • Number of visits: 1+ nights for inventory; 3 nights for monitoring.

 • Frequency: Annual for monitoring. 

 • Survey conditions: Conduct counts in calm, fine weather, and avoid listening during rain, 
strong wind and when there are other excessive noises (planes, trains, automobiles). Moon 
phase and visibility, and cloud cover must be recorded, as this helps when analysing and 
interpreting the results (E. Williams et al. unpubl. data). For criteria, see Appendix 2.

  Where should counts be made?

 • Number of count stations: At least two.

 • Location of count stations: Position stations so that no shoreline is > 1 km from a count 
station. 

 • Distance between count stations: 500 m.

  Data recording

 • Datasheets: The standard field form that is used for monitoring can be used (Appendix 3; 
DOCDM-1298092).

 • Data storage: Enter data into the Department of Conservation’s national bittern database 
(a Microsoft Excel spreadsheet; DOCDM-712082) or send records to the authors. 

 • Analysis and reporting: Population trend analyses are relatively specialised, so the advice 
of a statistician is useful before analysing results. Trend analyses can be graphed (e.g. Fig. 4) 
and distributions can be shown on maps (e.g. Fig. 5). Note: It is not straightforward to 
interpret the results from triangulation alone because the ability to differentiate between 
individual birds varies and seems to depend upon the observer’s location (see above).

 5.4 Estimate (index) of the number of booming males using 
Acoustic Recording Devices (ARDs) (inventory & 
monitoring)

  About this protocol

 • Measures: Automated dawn counts of booming male call rates using recording devices as 
a one-off inventory or for longer term monitoring (E. Williams et al. unpubl. data). Counts 
can be repeated in the same way annually to obtain data on:

 – Changes in the mean calling rates of birds detected
 – Occupancy (site occupancy of a standard number of recording stations)

 • Means of detection: Detects the calls of breeding males (booms) using automated 
recorders.
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 • Suitability: This method is particularly suitable for large wetlands where it is not possible 
to map the locations of bitterns or across a network of sites. In these situations, an index of 
call activity is used as a surrogate for estimating actual numbers (E. Williams et al. unpubl. 
data). ARDs can also be used for one-off inventories.

 • Advantages: Allows remote inventory and monitoring without the need for observers to 
work at night or in remote and inaccessible wetlands. 

 • Disadvantages: Requires the allocation of time for processing sound files once recorders 
have been retrieved from the field and adherence to precise analytical protocols  
(see Appendix 5 for instructions).

 • Differences between inventory and monitoring approaches: If using this method for 
long-term monitoring, counts should be made over a shorter standardised time period. 
Recording of dawn and dusk counts is useful for one-off inventories, but only dawn counts 
need to be recorded for monitoring.

  Field protocol

 • Observers programme ARDs (see Appendix 1 for instructions), deploy the recorders in the 
field during the day and return at a later date to retrieve them. 

 • The recorders can be mounted on trees or posts using the brackets provided (Fig. 6). 

 • Recorders can be retrieved at a later date and data can then be downloaded back in the 
office or to a laptop in the field if they are being redeployed immediately. Data are recorded 
on memory (8-GB SD) cards and easily downloaded to a computer for later processing  
(see Appendix 5).

  When should counts be made?

 • Time of year: September, October and early November, during the peak calling season for 
one-off inventory, BUT for a shorter period (last 2 weeks of September and all of October) 
during the highest calling period for monitoring (Fig. 2). 

Figure 6.   The deployment of an automatic bittern call recorder (acoustic recording Device; arD) at 
Cascade wetland, South Westland. Photo: Colin O’Donnell.
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 • Time of day: Set recorders to capture data for 1.5 hours before local sunrise, as this is the 
period when bittern calling rates are generally highest (Fig. 3A). Sampling for one-off 
inventories can also include the second (lower) peak of activity 30 minutes before local 
sunset to 1 hour after local sunset (Fig. 3B). 

 • Number of visits: 1+ nights for survey; 3 nights for monitoring. It is possible to set 
recorders for longer periods (e.g. up to 20 days), which allows the selection of records from 
days with good weather and allows nights when it was raining or windy to be discarded 
when carrying out monitoring. 

 • Frequency: Annual for monitoring. 

 • Survey conditions: Conduct counts in calm, fine weather, and avoid listening during rain, 
strong wind and when there are other excessive noises (planes, trains, automobiles). Moon 
phase and visibility, and cloud cover must be recorded, as this helps when analysing and 
interpreting the results (E. Williams et al. unpubl. data). Weather conditions are collected 
remotely or using local weather stations after the monitoring period. For criteria, see 
Appendix 2.

  Where should counts be made?

 • Number of count stations: The number of count stations required will depend on what 
level of population change the observer wishes to detect and over what time period. 
The more counts that are conducted, the higher the chance of detecting small changes 
in population indices—if small changes need to be detected over a few years, a large 
number of counts (hundreds) will be needed to make inferences about population trends. 
Therefore, we recommend a minimum of 40 count stations per year per study site for long-
term monitoring. The collection of data from 40 stations should allow annual population 
changes in the order of ± 10% to be detected with 90% certainty if monitoring is conducted 

over 5 years. Monitoring periods will 
need to be longer (10+ years) to improve 
predictions (E. Williams et al. unpubl. 
data). 

 • Location of count stations: For 
monitoring, the aim is to establish a 
number of count stations that represent 
typical habitat and are spread across the 
habitat to encompass the range of the 
population of interest. Thus, stations 
need to be spread widely across sites  
(e.g. Fig. 7).

 • Distance between counts stations: 
500 m or more (so that counts are 
relatively independent).

Figure 7.   an example of the layout of australasian bittern (Botaurus 
poiciloptilus) monitoring stations (red dots) at Whangamarino 
wetland, Waikato. Grid squares are 1 km x 1 km. 
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  Data recording

 • Datasheets: The standard field form that is used for monitoring can be used (Appendix 3; 
DOCDM-1298092).

 • Data storage: Enter data into the Department of Conservation’s national bittern database 
(a Microsoft Excel spreadsheet; DOCDM-712082) or other Excel spreadsheet (for example, 
see Appendix 6), or send records to the authors. 

 • Analysis and reporting: To analyse results for monitoring, record calling rates from 
a randomly selected 15-minute period from each 2-h sample. The results from field 
recorders can be collated by listening to the recordings and noting the number of call 
sequences present in each sampling period. Bittern booms have distinctive sonographic 
signatures (Fig. 8), so the number of boom sequences can be recorded visually using sound 
analysis software. We currently use RavenLite or RavenPro software (www.birds.cornell.
edu/; Appendix 5), which allow a sound file to be reviewed in 6–10 minutes (rather than 
15–20 minutes to listen to the whole sound file manually in the absence of software).Once 
sound files have been reviewed, population trend analyses will need to be carried out. 
These are relatively specialised and so the advice of a statistician is useful before analysing 
the results. Generalised linear mixed models will usually be suitable and trend analyses can 
be graphed (e.g. Fig. 4).

Figure 8.   Spectrogram of an australasian bittern (Botaurus poiciloptilus) boom sequence, showing the terms 
used to describe and identify bittern calls. Boom sequences often, but not always, consist of multiple booms 
that are preceded by a series of inhalations (or pumps). each individual boom within a sequence is made 
up of a first element and main element. Terms used here are in keeping with descriptions provided for the 
vocalisations of the eurasian bittern (Botaurus stellaris) (Gilbert et al. 1994). This spectrogram was produced 
using ravenPro (Bioacoustics research Program 2011) with 0–30 seconds on the x-axis, 0–700 hz on the 
y-axis and a sharpness setting of 2792 (e. Williams unpubl. thesis).
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 6. Decision guide to choosing protocols for a 
one-off survey versus long-term monitoring 
of Australasian bitterns 

The best method and approach for inventory or monitoring of an Australasian bittern population 
will depend primarily on the objectives of the work and the level of detail required. As such, the 
first stage in any programme is to set clear objectives. 

Most objectives revolve around three primary questions:

 • Are bitterns present at a site?

 • How many bittern are present?

 • What are the population trends over time?

The four protocols described in section 5 can be used to inventory or monitor Australasian 
bitterns, depending on which question(s) need to be answered. The best choice of method 
depends not only on the questions being asked, but also on the size and shape of the wetland, 
and whether or not kayaks or other watercraft can be used (Table 1). Protocols for an inventory or 
long-term monitoring use the same basic methods but need to be applied in different ways. For 
example, to undertake long-term monitoring of calling rates, the sampling periods need to be 
shorter and the focus is more on standardising count times and conditions to allow comparability 
over time. By contrast, for a one-off survey that has been designed to determine presence, the 
focus is more on optimising sampling during the period of maximum booming (see Section 5). 

We emphasise the need to follow the procedures outlined in the protocols as much as possible, 
particularly the guidelines on performing counts at optimal times and in the recommended 
conditions. The booming activity of Australasian bitterns varies markedly with season (Fig. 2) 
and time of night (Fig. 3), and a range of environmental variables (e.g. wind, rainfall, cloud cover, 
moon visibility) also affect activity (E. Williams et al. unpubl.). By surveying during optimal 
conditions, time and effort will not be wasted listening for calls when there is little chance of 
finding bitterns; and taking note of appropriate environmental variables when sampling will help 
in the interpretation of results, and enable analyses to be carried out that correct for factors that 
influence calling rate and detectability.
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QueSTiOn 

 

MeaSure 

 

TeChniQue 

 

STanDarD FielD 

PrOTOCOl 

rePOrTinG 

STaTiSTiCS 

DOCuMenT 

SeCTiOn/

reFerenCeS

One-off inventory:

1. are bitterns 
   present at a site?

Presence/absence 
during call inventories

1.1 Field observation evening counts of 
booming males using 
observers

• Proportion of sites 
   with booming 
   bitterns

• Time to first 
   detection

Section 5.1

1.2 acoustic 
      recording 
      Devices (arDs)

Dawn and dusk 
counts of booming 
males using recording 
devices

• Proportion of sites 
   with booming 
   bitterns

• Time to first 
   detection

Section 5.4

2. how many bitterns 
    are present?

estimate (index) 
of the number of 
booming males

2.1 Small wetlands  
      < 250 ha—close 
      approaches

evening counts of 
booming males using 
observers on shore or 
in kayaks

• Mean number of 
   birds recorded

• Locations of birds

Section 5.2
O’Donnell et al. 2013

2.2 Small wetlands  
      < 250 ha— 
      triangulation

evening counts of 
booming males using 
triangulation from 
fixed stations

• Mean number of 
   birds recorded

• Locations of birds

Section 5.3
O’Donnell et al. 2013

2.3 large wetlands— 
      calling rate per 
      15-minute sample 
      using arDs

Dawn counts of 
booming male call 
rates using recording 
devices

• Estimate of number 
   of birds derived 
   from call rate counts

Section 5.4
Williams et al. unpubl. 
data

Long-term monitoring:

3. What are the 
    population trends 
    over time?

estimate (index) 
of the number of 
booming males

3.1 Small wetlands  
      < 250 ha—close 
      approaches

evening counts of 
booming males using 
observers on shore 
or in kayaks repeated 
annually

• Change in mean 
   number of birds 
   and their locations

Section 5.2
O’Donnell et al. 2013

3.2 Small wetlands  
      < 250 ha 
      triangulation

evening counts of 
booming males 
using triangulation 
from fixed stations 
repeated annually

• Change in mean 
   number of birds 
   and their locations

Section 5.3
O’Donnell et al. in 
press

3.3 large wetlands— 
      calling rate per 
      15-minute sample 
      using arDs

Dawn counts of 
booming male call 
rates using recording 
devices repeated 
annually

• Change in call rate 
   over time

Section 5.4
Williams et al. unpubl. 
data

Table 1.    Decis ion guide for choosing the opt imal  protocol  for  carry ing out a one-off  inventory or long-term 
monitor ing of  australasian bi t terns (Botaurus poici lopt i lus )  in new Zealand wet lands dur ing September to 
november.
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  Appendix 1 

  Instructions for using automatic Acoustic Recording Devices 
(ARDs) (Ver B.2) for monitoring Australasian bitterns 
(Botaurus poiciloptilus) (adapted from Acoustic Recorder 
Instructions Ver B.2, Stuart Cockburn, Department of 
Conservation, Wellington)

  A1.1 Equipment
1–20 × automatic Acoustic Recording Device (Ver B.2) (available from the DOC Electronics 
Laboratory, Wellington, electronics@doc.govt.nz) 

1 × 8-GB SD card per recording unit

4 × AA rechargeable batteries per recording unit

  A1.2 How the recorder works
The recorder will automatically wake up at the preset ‘Start Time’ every day and will start to 
record continuously for the preset ‘Duration Time’. The rest of the time the recorder is asleep and 
draws very little power. 

  The sound files

The recordings are stored on the memory card as single channel .wav files in a folder called 
‘survey’. 

Sound files are stored as separate files of 15 minutes’ duration. Each file is named with the current 
date and time (6 digits + 6 digits separated by underscore), e.g. a sound file recorded on the 
26/02/10 at 9:24:06 PM will be named 260210_212406.wav. The files are also date stamped in the 
normal way so that the time/date created will appear in File Explorer.

The sound files can be played back on a computer or analysed using sound analysis software.

  Batteries 

The recorder uses four AA batteries, which can be either standard alkaline or rechargeable NiMH 
(recommended). High-capacity NiMH (2500+ mAH) batteries should last for over 100 hours 
of recording at the LOW sampling rate. This could equate to 10 days of 10 hours or 50 days of 
2 hours—the time between recordings has little impact on the battery capacity. Batteries can be 
expected to last for 25 days using sunrise and sunset bittern settings (4 hours per day) provided 
that an 8-GB memory card is used.

Battery life is dependent on the sampling rate, so only use the HIGH rate for species that require 
it. Using high sampling rate, the battery life reduces to about 50 hours. Therefore, if you are 
only targeting bitterns, set the sampling rate to LOW (so that high frequency sounds are not 
recorded), but if you wish to detect multiple species, e.g. bittern, marsh crake and fernbird, set the 
sampling rate to HIGH.   

Note: 

 • The only way to stop the recorder from running each night is to remove the batteries.

 • NiMH batteries will give much longer life and performance if they are always kept, used 
and charged in sets.
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Figure a1.1.   removing the cover of the recorder.

 

 

Figure A1.1.   Removing the cover of the recorder. 

  A1.3 Setting up the recorder
To open the recorder, remove the aluminium (or plastic) tube cover by gently twisting until the 
locators disengage and then pulling on the cover. Try to ease the tube off rather than allowing it 
to pull away and bash the recorder electronics inside. Also take care when replacing the cover to 
ensure that the SD card is not dislodged from its holder.

It is easiest to use your hands to lever the cover off, as shown in Fig. A1.1. 

 
 

 

 

 

 

 

 

 

 

 

Figure A1.2.   View of the inside of a recorder. 

 LCD display 
Buttons 

SD card 

Figure a1.2.   View of the inside of a recorder.

Once the recorder is open, you can see the display screen, control buttons and SD card slot on 
one side, and the battery holders on the other (Fig. A1.2). Try to avoid getting moisture or debris 
inside the recorder—use of silicon bead packets will help with this; they can be obtained from the 
conservation electronics team at the Department of Conservation (electronics@doc.govt.nz).

  Adjusting the settings

There are four yellow buttons on the recorder to navigate through the menu (Fig. A1.2).

The On/Page key (the left-hand button) wakes up the recorder and cycles through the pages in 
the menu.

The Plus and Minus keys (+/–) (the two right-hand buttons) modify the settings on the page.

The Shift key () (middle button) selects which value to modify.

  The settings

Press the ‘On/Page’ key to start the display. After a few seconds, the ‘time’ page will appear. You 
can then use the On/Page key to scroll through the various settings pages as outlined below:
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Time:  The current time, in 24-hour format.

Date: The current date, including the year, in DD/MM/YY format.

Start1+Span: The first start time for recording. The top line is the start time in 24-hour format 
 and the bottom line is the duration. If the duration is set to 00:00 then recording 
 at this time is disabled. For bitterns, set the timer to start 1 hour 30 minutes 
 before sunrise and set the duration as 02:00.

Start2+Span: As above, but for a second recording period. For bitterns, set the timer to start  
 30 minutes before sunset and set the duration as 02:00.

 Alternatively, if the recorders will only be in the field for < 5 days and storage 
 space for the sound files is not limiting, there is the option of setting ‘Start1’ and 
 ‘Span’ to 05:00 and 23:55, respectively. ’Span’ on the ‘Start2’ page is then set  
 to 00:00 (effectively turning the second timer off). This will produce 24-hour 
 recordings, which can be stored for analysis should a software package become 
 available in the near future.

Sampling: The audio sampling rate of the recorder. The options are LOW or HIGH.  
 For bitterns, set the timer to LOW.

Card: Checks the card (function and free space) or reformats the card.

On each page the Shift key ( ; middle button) can be used to select a value (the value flashes) 
and the Plus/Minus keys can be used to modify it. For example, on the time page use the Shift 
key to select either hours or minutes and then use Plus/Minus to change the values.

After about 20 seconds of no activity from the user, the display will power down. If you have not 
finished adjusting the settings, you may have to wake it up again and continue scrolling through 
the menu.

  A1.4 Deployment of units for bittern monitoring
The recorders can be mounted on trees or posts (the smaller the better, as large trees can cause 
unwanted blocking of the sound) using the brackets provided (Fig. A1.3). Each bracket can be 
attached to a tree using cable ties, screws, string, duct tape or whatever else is available. The 
recorder then sits in the bracket and is held in place by cable ties. We recommend the use of 

reusable ties, such as cable ties (e.g. http://nz.element14.com/, part 
number 1230926) or garden ties (e.g. MCGREGORS twist ties,  
www.mitre10.co.nz/, part number 153617).

For bittern monitoring, attach units to canes/poles at a height of 1.5 m. 
These should then be placed in the wetland at stations 500 m apart.

Surveys should only be conducted in fair weather conditions (avoid 
rain or strong wind), and avoid deploying units near potential 
disturbances such as trains, planes and automobiles.

 A1.5 Problems and queries?
For any electronic problems or questions, contact the conservation 
electronics team at the Department of Conservation (electronics@doc.
govt.nz).

For bittern monitoring related queries, contact Emma Williams (bittern.
wills@yahoo.com) or Colin O’Donnell (codonnell@doc.govt.nz).

Figure a1.3.   Mounting the 
recorder on a tree.

 

 

Figure A1.3.   Mounting the recorder on a tree. 
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  Appendix 2 

  Criteria for recording climate variables during bittern counts 

  A2.1 Noise

  Low—Light background noises:

 • Short/loud noises are brief and rare, e.g. banging doors, occasional car or other birds 
calling.

 • Continuous noises are quiet and not distracting, e.g. light drone of vehicles on motorway 
and/or train.

 • Overall, the observer does not feel distracted or have problems concentrating. Feels that no 
calls are being missed, even if the calling bird is very far away. Both short/loud noises and 
continuous noises are easy to ignore.

  Medium—Some background noises:

 • Short/loud noises occur regularly and last longer than 30 seconds each time.

 • Continuous noises are constant and loud enough that calls made far away may be missed.

 • Overall, the observer feels that some quiet calls may be being missed and may have trouble 
concentrating, e.g. tormented by the occasional mosquito.

  High—Lots of background noises:

 • Short/loud noises are regular and very distracting, e.g. geese/other waterfowl constantly 
gaggling, people talking or shouting.

 • Continuous noises are loud and close by, e.g. running water, highway, annoying 
mosquitoes.

 • Overall, the observer feels continuously distracted and frustrated by noises. Some calls may 
be missed, even if the bird is a medium distance away or close by.

  A2.2 Wind strength
Calm—May be able to feel a light breeze on the face, but branches and leaves are largely still or 
only move slightly.

Light—An occasional or constant breeze, but only light branches and leaves are affected. Leaves 
may rustle slightly but the noise is not distracting.

Moderate—Small branches move and sway. Leaves rustle but the wind is less than 10 knots. There 
is a constant wind.

Strong—Gusty, with large branches and leaves swaying. Rain is coming at a 45o or lower angle.

  A2.3 Moon visibility
1—Not visible, completely covered by clouds

2—Visible, completely covered and likely to stay that way for the majority of the survey

3—Visible, partially covered and likely to stay that way for the majority of the survey

4—Visible, no cloud

D/K—Don’t know; cannot see the moon because it has not risen or a physical feature is in the 
way, e.g. trees, hill or building

N/R—Not recorded
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  Appendix 3 

  Standard field sheet for recording bittern counts from general 
or triangulation surveys 
(Available at DOCDM-1298092 or codonnell@doc.govt.nz) 

 
 

 

SWAMP BIRD FIELD SHEET Site: Whangamarino
Date: 9/ 10/ 2009 Station No: Bi tt  1

WEATHER Temp: Cold / Cool / Warm Wind Dir. (e.g            SW
Wind Strength:Calm/ Light / Moderate / Strong - gusty

Other (e.g.rain)     No % Cloud Cove                 85
Playback used? No
Forward orientation of count (degrees)             46 degrees
Diagram of location of calls  
(Estimate the number of different individuals calling from a station 
through the count period)

NOTES (disturbances: cars, planes etc):

2 x Cars
Cows mooing
Low / Medium / High

SPECIES:        Bittern        Marsh Crake        Spotless Crake        Banded Rail        Fernbird        Morepork 

CALL NO. TIME Est. 
DISTANCE 
TO CALL(m)

No. CALLS Individual 
No.

COMMENTS/other species and times?

1 18:54:21 Far 3 A 135 degrees
2 18:55:25 Med 5 B 312 degrees
3 18:56:35 Med 4 B Cal l s over lapping. Bi rd C at  
4 18:56:35 Far 4 C bearing 10 degrees
5 18:58:36 Med 5 B
6 19:00:16 Med 5 B
7 19:00:38 Med 3 D 133 degrees
8 19:02:25 Med 4 B
9 19:04:41 Med 3 A
10 19:05:58 Med 5 B
11 19:06:21 Med 5 B
12

13

14

15

16

17

18

19

20

21

22

23

24

25

Observer: Emma Wi l l iams
Time Finish:  19:09Time Start:     18:54

Grid Easting:  1793353 Grid Northing: 5864536

Sunrise/sunset 

TOTAL NUMBER 
OF BIRDS 4                  

A

B

C D

 



25DOC Technical Series 38

  Appendix 4 

  Triangulation example

In this example the observers needed to address three areas of uncertainty:

1. Was bird A actually one or two birds? Station 2 only got one bird in this location but 
Station 1 got two. Station 1 is in the best position to distinguish between calls from this area 
and therefore the observers (correctly) concluded that there were two birds in the area.

2. Was there one or two birds in the southeastern corner of the lake? Here observers decided 
there was one bird (Bird I), as neither observer was in a position to get a good angle and 
both observers had recorded similar call characteristics (e.g. times of calls, number and 
frequency of booms). They concluded (correctly) that the calls they had both heard were 
from the same bird and the variability in their placements is most likely bearing error.

3. Were birds G and H one or two birds? Station 1 only recorded birds from one general 
location (G) but Station 2 had a greater ability to distinguish between these birds compared 
with Station 1 and therefore they concluded (correctly) that these were two separate birds.
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  Appendix 5 

  Detecting the calls of Australasian bitterns  
(Botaurus poiciloptilus) by visually analysing sound files  
(E. Williams unpubl. thesis)

  A5.1 Choosing a software package
The mono files that are recorded using the Department of Conservation’s Acoustic Recording 
Devices (ARDs) can be visually processed using the free software RavenLite or RavenPro 1.4 
(the latter is recommended but is only available for free on a 30-day trial). Depending upon the 
number of boom sequences recorded and the experience of the analyser, you can reasonably 
expect a 15-minute file to take an average of 6 minutes to process. The choice of which software 
package to use will depend upon the volume of sound files needing to be processed and what 
information the processor requires from the files. In general, the following recommendations can 
be made:

 • RavenLite is recommended if you are detecting bittern calls to determine basic presence/
absence or require a simple count of the number of calls for only a few files. It is free but 
you will need to register online to use the software.

 • RavenPro 1.4 is recommended if you need to process a large number of files, as it is much 
easier to use and has additional features, such as the ability to save a window preset and 
to process multiple files at the same time. It also allows you to obtain additional attributes 
easily, such as the energy (dB) or peak power (dB) of a call. Unfortunately, however, it is not 
free—refer to the website for more details on cost. Note that permission can be sought to 
trial the software for 30 days and New Zealand is one of the countries listed to qualify for a 
discount.

  A5.2 Downloading the software
Raven software (both RavenLite and RavenPro 1.4) can be downloaded from the Cornell Lab of 
Ornithology at the following web address: 

www.birds.cornell.edu/brp/raven/RavenVersions.html

First download the software and then follow the prompts on the website to get the relevant 
product licence. A licence is required to access the full functionality of the software regardless of 
whether it is free or not. As part of this process, you are likely to have to register your name and 
contact details with Cornell. Refer to the website to complete this process. 

For RavenPro 1.4 you should download the 63.0M version for Windows, the 30.9M version for Mac 
or the 28.9M version for Linux.

  A5.3 Opening the sound files (using both RavenLite and RavenPro)
Once the software is installed on your computer and your licence has been verified, you can start 
to analyse your files. Sound files can be opened in several ways, including:

 • Traditional method: Click on File > Open Sound Files and browse through your hard drive 
until you find the file of interested. Click on your file and then select ‘Open’.

 • Drag and drop method: On your computer, separately open the folder containing your 
sound file. Now left click on the sound file of interest, and then drag and drop the file into 
Raven by holding down your left mouse button.

To get you started, we recommend you open the example file provided (ST0032.wav). If this file 
has not been provided please contact Emma Williams (bittern.wills@yahoo.com) and ask for a 
copy to be sent to you. Regardless of which of the above methods you used to open your file, your 
screen should now look something like the screenshot in Fig. A5.1. 
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If you already have a preset window established for bitterns, follow instructions (a). If this is your 
first time processing soundfiles for bitterns then you will not have any presets established and 
need to follow instructions (b). 

(a) Selecting a preset window. Click on the downward arrow next to the preset box (Green 
circle, Fig. A5.1). This will produce a dropdown list of available presets. If ‘bittern’ is on the 
list, click on it and then click on ‘OK’ (Fig. A5.2). Your screen will now look like Fig. A5.3, 
and you are now ready to detect bitterns and can skip to instructions ‘Detecting bittern 
booms’ (A5.4). 

(b) Creating preset window settings to detect bitterns. With your screen looking like that in 
Fig. A5.1, Click on ‘OK’. Now you should have a screen that looks like the screenshot in 
Fig. A5.4. Here, you are looking at two views (shown by green arrows): the waveform  
(the upper window with blue lines on a white background) and the spectrogram (the lower 
window, which appears grey and fuzzy). To prepare your view so that you have the best 
chance of seeing bittern calls, follow these steps:

1. Turn off the waveform view. To do this, remove the tick that is in the box next to 
waveform 1 on the left-hand side of your screen (circled in green in Fig. A5.4). Now your 
screen should look more like the screenshot in Fig. A5.5.

2. Maximise the window by clicking on the button shown by the blue arrow (Fig. A5.5) so 
that your screen looks like Fig. A5.6.

 
 

Figure A5.1. View of starting screen for analysing bittern calls 

 

 

 
Figure a5.1.   View of starting screen for analysing bittern calls
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Figure A5.2. Drop down list of preset windows 

 

 

 
Figure a5.2.   Dropdown list of preset windows.

Figure a5.3.   View of an open sound file in ravenPro 1.4.

 
 

Figure A5.3. View of an open sound file in RavenPro 1.4. 
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Figure A5.4. Creating a preset screen to detect bitterns. 

 

Waveform 

Spectrogram 

Figure a5.4.   Creating a preset screen to detect bitterns.

 
 

 

Figure A5.5. View of an open sound file in RavenPro 1.4 only showing the spectrogram. 

 
Figure a5.5.   View of an open sound file in ravenPro 1.4 only showing the spectrogram.
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Figure a5.6.   View once the waveform has been turned off and screen size maximised.

 
 

 

Figure A5.6. View once the waveform has been turned off and screen size maximised. 

 

3. Now set the view so that you are looking at < 900 Hz (y-axis) and 0–30 seconds (x-axis). 
To do this, left-click on the spectrogram and, while holding your left mouse button 
down, draw a box over the area you wish to zoom to in the lower left of the spectrogram. 
The screen should now look like something like Fig. A5.7. 

4. You can now zoom into your selection by clicking on the button marked by the green 
circle in Fig. A5.7, to give you something that looks like the screenshot in Fig. A5.8 
(which looks horrific!). If you are not happy with your selection, you can reverse it by 
clicking on the ‘expand’ button, which is found to the right of the zoom button (see 
Fig. A5.9), and try again.

5. Once you have zoomed to an area that you are happy with you will need to alter the 
sharpness (see Fig. A5.10). A value of around 2792 is recommended.

6. Next, change the colour of the spectrogram using the colour map drop box (circled in blue 
on Fig. A5.11). The option ‘hot’ is useful for seeing bitterns, but the choice is really personal 
preference. Now your screen should look like Fig. A5.12.

7. The bittern boom sequences should now be visible (circled in blue in Fig. A5.13). Note: There 
are three booms within this single sequence; the last two are quite obvious, but if you look 
closely and listen with good quality headphones you will discover that there is also a poor 
boom at the beginning of the sequence (shown by the blue arrow).

8. Scroll through the file looking for any bittern calls. To do this, left-click anywhere on the scroll 
bar (area marked with a green square in Fig. A5.12). This will move your screen along at a rate 
of 15 seconds per click.
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Figure A5.7. Drawing a box over the area you wish to zoom to in the lower left of the 

spectrogram. 

 
Figure a5.7.   Drawing a box over the area you wish to zoom to in the lower left of the spectrogram.

 
 

 

Figure A5.8. Zooming into an area of interest before sharpening the image. 

 

 
Figure a5.8.   Zooming into an area of interest before sharpening the image.
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Figure A5.9. Showing the expand button (circled in blue). 

 
Figure a5.9.   Showing the expand button (circled 
in blue).

Figure a5.10.   alter the sharpness to a value of 
around 2792.

 
 

Figure A5.10.    Alter the sharpness to a value of around 2792. 

 

 
 

Figure A5.11. 

 

 
Figure a5.11.   View after zooming in to the selection. The colour map drop box, where you can change the colour 
of the spectrograph, is circled in blue. The option ‘hot’ (3rd down) is recommended for seeing bittern booms.

Figure a5.12.   View after changing colour to ‘hot’.

 
 

Figure A5.12. View after changing colour to ‘hot’. 
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 A5.4 Detecting bittern booms
You are looking for a series of small yellow/white signatures sitting at around the 150-Hz mark. 
Once you have found a suspect signature at this frequency, you should look at the following:

 • If more than one signature is present, do they appear in a pattern, with each signature 
roughly spaced at regular intervals? If so, the call is likely to be a bittern and worth 
further investigation. However, do not expect interval distances to be perfectly uniform. 
Occasionally, booms within a sequence will appear to be missing or only have a faint trace, 
so be aware that there can be a lot of variability. The distance between bittern booms is 
usually about 1–3 seconds, but can be up to 10 seconds, particularly early in the booming 
season. 

 • Are there any other patterns above the suspect signature? Bittern calls do not leave any 
imprints at frequencies higher than 200 Hz, so if patterns are appearing above the suspect 
signature then it is either not a bittern or something has produced a noise at the same time 
as the bittern. 

You may need to listen to confirm that what you are seeing is definitely a bittern boom, 
particularly when you are starting out. If in doubt, you are welcome to take a screenshot or cut 
that section of the call and send it to Emma Williams (bittern.wills@yahoo.com) for a second 
opinion. Note: It is not uncommon for bitterns to produce single booms, or for one or more of the 
booms in a sequence to be less well defined. 

Figure A5.14 shows several sample boom sequences that illustrate some of the variability you 
may encounter:

A. One boom sequence containing three ‘good’, well-defined booms.

B. One boom sequence containing three booms. Inhalations are visible around the 200-Hz 
mark in this example.

C. One boom sequence containing three booms. This is much earlier in the booming season 
when the booms from some individuals are fainter and less well defined. 

D. One boom sequence containing two booms. If you look carefully, the inhalations are 
visible. Again, this is a recording taken much earlier in the season when the booms of some 
males sound more ‘cough-like’.

E. One sequence containing two booms that are barely visible because of faint train noises in 
the background. This example highlights the importance of careful placement of recording 
units.

F. One sequence containing four booms that are barely visible because of high background 
noise (wind).

Figure a5.13.   Bittern booms become visible after changing the sharpness of the view to 2792.

 
 

Figure A5.13.  Bittern booms become visible after changing the sharpness of the view to 

2792. 
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Figure A5.14.   Examples of bittern boom sequences, showing the level of variation (see 
text for detail). 

 

 

 

 

 

 

 

 

 

 
 

 

 

A B

C D 

E 

F
 

 

G 

Figure a5.14.   examples of bittern boom sequences, showing the level of variation (see text for detail).

G. One sequence that contains at least three (but possibly four) booms. This sequence is also 
barely visible because of high background noise (wind).

Figure A5.15 shows some typical background noises:

H. Light wind can hide a bittern boom.

I. Cows can leave signatures at a similar frequency to bitterns but, unlike bittern signatures, 
will continue up at higher frequencies. Pūkeko (Porphyrio porphyrio melanatus) also make 
some calls that show as signatures around 200 Hz, which is why it is important to check 
for any imprints up to 800 Hz—if similar signatures appear at higher frequencies, it is very 
unlikely to be a bittern.

J. Swans can leave vocal signatures at a similar frequency to bitterns but, unlike bittern 
signatures, these calls are slightly lower in frequency and the signature often repeats at 
higher frequencies (approximately 300–350 Hz).

 A5.5 Listening to files to confirm booms
Listening to files can help to confirm a boom that is suspect. To do this, click on the window 
somewhere just before the suspect boom and play the file using the play button (circled in  
Fig. A5.16).

To hear bittern calls, you may need to invest in a pair of headphones that are of reasonable 
quality. Cheap headphones often do not cope well with lower frequency sounds such as bittern 
calls. We use Sennheiser headphones (HD 201 or HD 202), which can be purchased from most 
electronic stores and cost approximately NZ$80. If in doubt, use the example soundfile provided 
(ST0032.wav) and its associated Excel spreadsheet (ExampleData.xls) to test that you can hear 
the bittern calls with your headphones. If you have not received a copy of these files and wish to 
do so, please contact Emma Williams (bittern.wills@yahoo.com)
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Figure a5.15.   Disturbances that affect the ability to detect bitterns (see text for detail).

 
 

Figure A5.15.   Disturbances that affect the ability to detect bitterns (see text for detail). 
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Figure A5.16. Play button. 

 
Figure a5.16. Play button.

 A5.6 Creating window presets (RavenPro only)
Once you are happy with your settings, you may wish to save them so that you can go straight to 
the optimal settings to see bittern calls as soon as each file is loaded. 

To do this:

1. Make sure all of your settings are correct (see section A5.3).

2. Save your settings by clicking on View > Window Preset > Save As… (see Fig. A5.17).

3. Choose a suitable name for your preset (in this case ‘Bittern’ is appropriate). 

4. Now, every time you open a file, select View > Window Preset > Bittern and your window 
will zoom automatically to the optimum settings to view bittern booms.

 A5.7 Selecting additional attributes to be measured (RavenPro only)
Depending upon your aims and objectives, you may wish to measure some additional attributes 
for each call found. These can be found below your spectrogram under the tab ‘Table 1’: 

1. First, expand your view so that you can see the full table. To do this, left-click on the area 
shown in the green circle on Fig. A5.18 (note: when you do this, your cursor should change 
to a double-headed arrow as shown in the figure).

2. While holding your left mouse button down, drag the window upwards until you can see 
the full table. 
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Figure a5.17.   Creating preset window settings.

 
 

Figure A5.17. Creating preset window settings. 

 

 
 

Figure A5.18.  

 

 
Figure a5.18. expand the ‘Table 1’ tab by holding your mouse button down and dragging the bar upwards 
until the whole table is visible.

3. You will now see that your table already has some headers, e.g. ‘Selection’, ‘View’ and 
‘Channel’. If you right click on any of these headers you will get a dropdown list  
(Fig. A5.19). Go to ‘Choose Measurements’ from this list.

4. Now you can move any measurements that you are interested in into the left-hand box  
(see large blue circle on Fig. A5.20) using the double arrows (small circle on Fig. A5.20).
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Figure A5.19. 

 

 

 
Figure a5.19. Drop-down list showing ‘Choose Measurements’ option.

 
 

Figure A5.20. Choosing your measurements. 

 
Figure a5.20. Choosing your measurements.

The following measurements are recommended:

Begin File—Contains the file name

Begin Time (s)—The number of seconds into the file where the boom starts

End Time (s)—The number of seconds into the file where the boom finishes

Low Freq (Hz)—Defines the bottom edge of the box you created

High Freq (Hz)—Defines the top edge of the box you created

Energy (dB)—The total energy within your defined area
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Peak Power (dB)—The maximum power within the defined area; when using the colour ‘Hot’, this 
will be the power reading at the lightest point in the defined area 

Avg Power (dB)—Measures the power per pixel and averages this across all pixels in the 
selection

You can change the order of your list by clicking and dragging attributes into the order that you 
would prefer. Reorder this list so that they are the same order as the spreadsheet that you are 
storing you data in.

Once you are happy with the list and its order, click on ‘Apply’. Now you are ready to take your 
measurements. If you have already created a preset window called ‘Bittern’, you should resave it 
with these settings by clicking on View > Window Preset > Save ‘Bittern’.

 A5.8 Measuring additional attributes of the call (RavenPro only)
To measure these additional attributes, first draw a box around the area you wish to assess—in 
this case, a single bittern boom. Take care to keep your box as small as possible so that you only 
include the specific sound you are interested in. Measurements for each of the attributes of this 
call will now appear automatically in the selection table at the bottom of your screen (Fig. A5.21).

You can copy and paste these into another program, e.g. Microsoft Excel. To do this, highlight 
the cells by clicking on them, then right click and go to ‘Copy Selected Cells’ (Fig. A5.22). Now 
they can be pasted wherever you would like them to go, e.g. in the relevant cells of Excel. Note: 
Holding down ‘Ctrl’ and ‘C’ does not work in Raven.

Figure a5.21.   Showing additional attributes of the call in ravenPro 1.4.

 
 

Figure A5.21.   Showing additional attributes of the call in RavenPro 1.4. 
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Figure a5.22.   Copying the call attributes for use in another program.

 
 

Figure A5.22.   Copying the call attributes for use in another program. 

 

 

 

 A5.9 Processing your sound files and entering your data
Each time you want to process a sound file you just have to complete the following steps:

1. Load the file (see section A5.3—‘Opening sound files’ if you need a reminder of how to do this).

2. Zoom to the relevant preset view (see section A5.6) by clicking on View > Window Preset > 
Bittern (if applicable).

3. Scroll through the file looking for any suspect calls by clicking on the scroll bar to move 
the screen forward by 15 seconds with each click (see area marked with a green square in 
Fig. A5.12):

  If you find a call (or a suspect call), first have a listen (see section A5.5—‘Listening to files 
to confirm booms’). If you are not sure whether or not it is a bittern, you are welcome 
to send screenshots and sound files to Emma Williams at bittern.wills@yahoo.com for 
a second opinion. If it is a bittern, draw a box around each boom, then copy and paste 
the attributes that appear in the bottom of your screen into Excel as you go (see section 
A5.8—‘Measuring additional attributes of the call (RavenPro only)’). Note that ‘Ctrl’ and 
‘C’ does not work in Raven. Add your initials under Processor, ‘Bittern’ in the species 
column, and number the booms (Boom#) and call sequence (Call#) accordingly; for 
example, if it is the second boom of the first call sequence to be found in that file, put 
one in the ‘Call#’ column and two in the ‘Boom#’ column. So if, for example, you found 
five booms in the first call sequence of a file, you would expect to input five rows of data 
numbered 1–5 under the column ‘Boom#’, each of which would be labelled with a 1 under 
the column ‘Call#’; if you then found that the second call sequence on the same file had 
two booms, you would expect to enter two rows of data numbered 1–2 under ‘Boom#’, 
each labelled with a 2 under ‘Call#’.

 If no calls are found in a file, enter the file name in a row of your Excel spreadsheet, add 
your name as a processor and put ‘NONE’ in the column species. Now you are ready to 
start the next file.
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